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Mejoras

1) Mejora en velocidad de Diseño no-disipativo

2) Mejora en elemento no-disipativo por NTC2018

3) Mejora en diseño a cortante por NTC2018

4) Combinación de carga para resultado de diseño de concreto por resistencia elástica

5) Adición de modelo de rótula por EC 8 :2004 

6) Adición de coeficientes de reducción de la capacidad de disipación de energía 

por irregularidades según NSR-10

7) Mejoras en la función de presión de viento

8) Adición de material de barra de refuerzo a Base de Datos (Barra imperial U.S.)

9) Mejoras en el diseño a cortante de pórticos especiales de concreto según ACI318

10) Configuración asimétrica de Beam End Offset

11) Función de presión de suelo estática

12) Resultados gráficos de los link elásticos multi-lineales para análisis pushover

13) Longitud no adherida en viga pretensada

14) Conexión con Revit 2021

• midas Gen
4

• midas Design+
1) Generación de reportes en formato Excel

2) Módulo de columna SRC con adición de secciones metálicas (box/pipe)

3) Opción de Link Midas link

4) Adición de diseño de zapatas combinadas por Eurocode

5) Reducción de tiempo en la generación de reportes en formato Word
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• Reducción del tiempo de diseño optimizando el cálculo de m-phi y mejorando el algoritmo de salida

1. Mejora en velocidad de Diseño no-disipativo

Gen 2020

Gen 2021

Tiempo para el cálculo de M-Phi Tiempo para diseño

✓ Vigas / columnas: 1,974 elementos

✓ Muros: 216 elementos

✓ Combinaciones de carga: 100

664.01seg

Modelo de ejemplo (estructura concreto reforzado  de 6 pisos)

[Tiempo total de diseño de ND: Gen 2020 vs Gen 2021 (nueva versión)]

Reducción del 60% en el tiempo de diseño

Tiempo ahorrado

274.54seg 389.47seg

midas Gen
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2. Mejora en elemento no-disipativo por NTC2018

Tabla de Diseño – Diseño a flexion y cortante no-disipativo
- Salida de resultados separados para ULS excepto acción sísmica y ELS con sísmica modificada por q para elementos no 

disipativos

* LC_A : Load combination to check ULS(Ultimate Limit State) except seismic loads

* LC_E : Load combination to check ELS(Elastic Limit State)

* LC_S : Load combination to check SLS(Serviceability Limit State)

Ultimate Strength Check (LC_A) en diseño gráfico

Elastic Strength Check (LC_E) en diseño gráfico

Serviceability Check (LC_S) en diseño gráfico
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2. Mejora en elemento no-disipativo por NTC2018

Reporte gráfico – Diseño a flexion y cortante no-disipativo
- Genere resultados de diseño para ULS, ELS y SLS por separado en informes de diseño.

Resultado de diseño para ULS(Ultimate Limit State) Resultado de diseño para ELS(Elastic Limit State)

Resultado de diseño para SLS(Serviceability Limit State)
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Diseño Fuerza cortante de elementos primarios según NTC 2018
- Al calcular una fuerza cortante de diseño para elementos primarios, la fuerza del miembro puede limitarse por una demanda de 

resistencia para combinaciones de carga ELS.

La demanda de resistencia evaluada con los criterios de diseño de 

capacidad se puede asumir no mayor que la demanda de resistencia 

evaluada para el caso de comportamiento estructural no disipativo.

Design report (Detail)

3. Mejora en diseño a cortante por NTC2018

VzOrig = Design shear force by ULS load combination

Ve1(M) = Design shear force by flexural strength of member.

Ve1(E) = Design shear force by ELS load combination.

V_Ed = Max [VzOrig, Min[Ve1(M), Ve1(M)]]
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3. Mejora en diseño a cortante por NTC2018

Diseño Fuerza cortante de elementos primarios según NTC 2018
- Al calcular una fuerza cortante de diseño para elementos primarios, la fuerza del miembro puede limitarse por una demanda de 

resistencia para combinaciones de carga ELS.

Check on optionCheck off option

--> V_Ed = Max [VzOrig, Min[Ve1(M), Ve1(E)]]

VzG = Design shear force by load combination with only gravity loads.

Ve1(M) = Design shear force by flexural strength of member.

Ve1(E) = Design shear force by ELS load combination.

--> V_Ed = Max [VzOrig, Ve1(M)]

Opción agregada.

Design Setting
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4. Combinación de carga para resultado de diseño de concreto por 
resistencia elástica
Se agregaron resultados gráficos para la combinación de carga ELS.

✓ ULS : Load combinations assigned to “Strength/Stress” type in Load combination dialog box

✓ ELS : Load combinations assigned to “Strength(Elastic)” type in Load combination dialog box
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Nuevo modelo de rotula por Eurocode 8 :2004 
- Adición de curva de rotula con tipo “Du update”

5. Adición de modelo de rótula por EC 8 :2004 

midas Gen

Dy1 Dy2 Du1 Du2

Stiffness without 
considering Axial force

Stiffness considering 
Axial force

Stiffness and Dy are changed by axial force 
Under PMM or PM type.

Dy1
=Dy2

Du1

Stiffness without 
considering Axial force

Stiffness considering 
Axial force

Stiffness and Du are changed by axial force 
Under PMM or PM type

Du2

* Du1 - Dy1 = Du2 – Dy2

Du Update

(Agregada a Gen2021 nueva)
Actualización de Dy

(compatible con la versión antigua)

[Calculation of Du (= θu, Ultimate Rotation)] [Calculation of Dy (= θy, Yielding Rotation)]

𝜃𝑦 = 𝑘 × 𝜀𝑦 ÷ 𝐷𝑒𝑝𝑡ℎ 𝑜𝑓 𝑒𝑙𝑒𝑚𝑒𝑛𝑡

* εy : Yielding strain at tensile face

✓ Note
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• Results > Results Tables > Story> Stiffness Irregularity Check, Capacity Irregularity Check, and Mass Irregularity Check

6. Adición de coeficientes de reducción de la capacidad de disipación de energía 
por irregularidades según NSR-10

Factores de reducción (Phi_p)

Chequeo Irregularidad de rigidez

Chequeo Irregularidad de capacidad

Chequeo Irregularidad Masa

De acuerdo con la Tabla A.3-7 en NSR-10,
Gen informa el factor de reducción, ø en las 
fuerzas de diseño sísmico para tener en cuenta 
la verificación de irregularidades

• Estructuras Regulares øa = 1.0
• Irregulares Estructuras øa = 0.9
• Estructuras Irregulares Extremas øa = 0.8

✓ Nota

1. Chequeo Irregularidad de rigidez (piso flexible)

2.Chequeo Irregularidad de capacidad (Piso débil)

3. Chequeo Irregularidad Masa

• Estructuras Regulares øa = 1.0
• Irregulares Estructuras øa = 0.9
• Estructuras Irregulares Extremas øa = 0.8

• Estructuras Regulares øa = 1.0
• Estructuras Irregulares øa = 0.9
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Inserción de presión de suelo con edición de tabla
- La presión de viento generada por ecuación en tabla puede ser editada y actualizada en el modelo

7. Mejora en función de presión de viento

midas Gen

Gen 2021 v1.1 (Nueva versión)

Inactivo

Al editar los valores de la tabla, la presión del viento se modifica automáticamente.

Gen 2020
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• Proporcionar información de barras para el diámetro, el área y el peso en el cuadro de diálogo

• Adición de barras de refuerzo #2 y #12 en la base de datos estándar de EE. UU. (Imperial de EE. UU.)

8. Adición de base de datos de materiale (Barra imperial U.S.)

midas Gen

Gen 2021 v1.1 (Nueva versión)Gen 2020

Agregue barras de refuerzo 

#2 y #12 en el código de 

Estados Unidos.

Además, proporciona la información detallada para Rebar DB

Proporciona solo la función para seleccionar 

el tamaño de las barras.



Gen 2021 v1.1 Release Note

14 /31

midas Gen

9. Mejoras en el diseño a cortante de pórticos especiales de concreto según ACI

El factor de reducción (R) para Vc no se usa en la mitad del tramo del miembro.
- ‘Vc=0’ se considera solo en ambos extremos del miembro.

Gen 2021 v1.1 (Nueva versión)

Gen 2020

✓ Nota

Provisiones sísmicas en ACI 318M-19 

Vc en Diseño = R*Vc
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10. Configuración asimétrica de Beam End Offset

Gen 2020

Gen 2021 v1.1 (Nueva versión)

Adición tipo de elemento (Asymmetric)
- Establezca un beam end offset para cada dirección
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11. Función de presión de suelo estática

Adición de presión de suelo estática tipo función.
- - Al editar los valores de la tabla, la forma de la presión del suelo en el modelo se modifica automáticamente.

Establezca caso de carga y dirección

Seleccione la función de 
Propiedades del suelo

Establezca área de carga

Revise curva de carga por nivel

Configure el tipo de presión de la 
tierra, la sobrecarga y el nivel del 

agua

Load > Static Loads > Lateral > Earth Pressure > Static Earth Pressure

Hoja de Cálculo
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12. Resultados gráficos de links elásticos en análisis pushover

Adición de salida gráfica del enlace elástico (tipo multilineal) en el análisis pushover

Pushover >  > Pushover Results > Pushover Smart Graph > Elastic Link Graph 

Tipo de Resultado

1.[Force-Deformation] : Force/Deform.

2.[Force] : Force / Time

3.[Deformation] : Deformation/Time

Ubicación/Componente

Seleccione Elastic Link

1.Ubicación : Posición de salida de elementos

2.Componente: Stress-Deform/ ángulo

Momento-Rotación en eje de elemento

Gráfica /Animación

Opciones de Display

Todos los enlaces elásticos asignados al 

modelo se muestran en la lista.

Para el mismo tipo, son posibles varias 

selecciones.

La función de animación comprueba los 

resultados en una sección específica.

Puede comprobarse junto con

los resultados de la tabla

Después de comprobar cada elemento, haga 

clic en el botón [Gráfico] para aplicarlo al 

gráfico.
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13. Longitud no adherida en vigas pretensadas

• La longitud no adherida de la viga pretensada se puede definir directamente al crear torones desde el cuadro de diálogo "Perfil de 

tendón".

• Defina la longitud total real del torón, incluidas las partes no adheridas en ambos extremos y luego ingrese las longitudes de las 

partes no adheridas.
Load > Temp./Prestress > Prestress Loads > Tendon Profile

Cuando la longitud no adherida no es cero, diagrama de momento primario del tendón

Cuando la longitud no adherida tiene 0, diagrama del momento primario del tendón
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14. Interfaz con Revit 2021

Gen-Revit Link
Functions Revit <> Gen

Linear 

Elements

Structural Column  <>

Beam  <>

Brace  <>

Curved Beam  >

Beam System  >

Truss  >

Planar

Elements

Foundation Slab  <>

Structural Floor  <>

Structural Wall  <>

Wall Opening & Window  >

Door  >

Vertical or Shaft Opening  >

Boundary

Offset  >

Rigid Link  >

Cross-Section Rotation  >

End Release  >

Isolated Foundation Support  >

Point Boundary Condition  >

Line Boundary Condition  >

Wall Foundation  >

Area Boundary Condition  >

Load

Load Nature  >

Load Case  >

Load Combination  >

Hosted Point Load  >

Hosted Line Load  >

Hosted Area Load  >

Other 

Parameters

Material  <>

Level >

▪ File > Import > midas Gen MGT File

▪ File > Export > midas Gen MGT File

Revit 2021 Gen 2021 v1.1 (Nueva versión)

Send Model to midas Gen
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1. Reporte en formato Excel

Generate a report of excel format.

Reporte Miembros

Reporte Lista de Miembros
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1. Reporte en formato Excel

Reporte Excel Reporte LibXL

• Proporciona resultados de alta calidad

• Se pueden utilizar todas las funciones de Excel.

• Velocidad de generación de salida muy rápida

• Expresión en el mismo formato que Informe de texto
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2. Módulo de columna SRC con secciones cajón y tubulares

▪ Código de diseño aplicado: AISC-LRFD16 (M), 10 (M)

▪ Forma de acero aplicada: sección H, cajón, tubería

Adición secciones Box y Pipe
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2. Módulo de columna SRC con secciones cajón y tubulares

Columna SRC con sección Box Columna SRC con sección Pipe

Ejemplo

Columna SRC con sección H



Gen 2021 v1.1 Release Note

25 /31

midas Gen

3. Opción de Midas link

Link Option > Member Data

✓ RC 

Column / General Section Column

Shear Wall / Combined Wall

Footing (Isolated/Combined/Strip)

Anchor Bolt

✓ Steel

Beam / Column

Bolt Connection (EC3)

Moment Connection( KSSC, AISC, EC3 )

Baseplate / Embedded Plate

Web Opening

Welding

✓ SRC

Column

CFT Column

✓ Aluminum

Beam / Column

General Section Beam / Column

✓ Reinforce

Reinforced Beam

Reinforced Column

- Función de enlace de apoyo para todas las combinaciones 

creadas en Gen

▪ Adición de tipo “by all combination" en el tipo de combinación de carga.

Lista modulos con [ by All Load Combination ]
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Ejemplo para tipo “by All Combination” 

1. Genere una combinación de carga y seleccione una columna.

2. Establezca el tipo de combinación by All Load Combination

en Link Option> Member Data> Column tab.

3. Verifique el número de miembro e importe la información de diseño de 

los miembros.

4. Verifique la Lista de miembros en el menú del árbol de RC.

1

2

3

4

3. Opción de Midas link
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5. Haga clic en el botón “Load Combinations".

6. Verifique el nombre de la combinación de carga y la posición final del miembro antes de diseñar / verificar.

* En el caso de las columnas RC, se importan las fuerzas de los miembros de los extremos I y J por 

combinación de carga.

Recomendado para comprobar la posición del diseño.

3. Opción de Midas link

Ejemplo para tipo “by All Combination”

5

6
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4. Diseño de zapatas combinadas por Eurocode

Adición de diseño de zapata combinada según Eurocódigo 2: 04



Gen 2021 v1.1 Release Note

29 /31

midas Gen

Procedimiento de diseño de zapatas combinadas

Defina Sección Defina Carga Defina información de columna Defina arreglo de barras

Paso 1.

Definir hormigón, material de 

armadura, capacidad del suelo

e información del elemento de la 

zapata.

Paso 2.

Definir datos de carga.

(Carga de diseño, factor, 

información de corte (Shear

offset))

Paso 3.

Defina el elemento de 

columna e información de

carga aplicada.

Paso 4.

Defina arreglo de barras y espaciamiento

4. Diseño de zapatas combinadas por Eurocode
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Reporte de Diseño resumido Reporte de Diseño detallado

4. Diseño de zapatas combinadas por Eurocode
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5. Velocidad de informes para formato MS Word

• El tiempo de presentación de informes para el formato MS Word se ha reducido mejorando el algoritmo.

✓ Código Nacional : Eurocode2:04

✓ Módulo: Combined Footing Design

✓ Páginas de Reporte: 13 cada una

Design+ 2020

Design+ 2021

28.66 seg

[Tiempo de Reporte :  Design+ 2020  vs Design+ 2021 (Nueva Versión)]

99% reducción en tiempo de reporte

0.41seg

Ejemplo Modelo ( Estructura RC de 6 pisos )


